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Who can do?

* Fresh Matriculation who are interested to learn
Matrix and Jewelry Design Software

* Already working professional who are looking a
better Prospect in Jewelry Designing

= People who are working in same domain would
like to learn latest software of Jewelry Designing.

= People who would like to get certification in this

era.
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Course Objectives

Create interactive images of your Matrix designs for your customers to
view via email or from your company’s website. These three dimensional,
photo realistic images provide full control to the viewer; allowing them to
spin, reposition, zoom in and out, and even change gem or metal materials
with immediate results! With your design opened in Matrix and a few
simple clicks using the Matrix Viewer tool, you can create files used to
share your designs with the world in an exciting new way - and they don't
need a 3D program to view it!

Suite # 7, Nobel Heights, Opposite Sales Tax House, KDA Scheme # 7, Main University Road — Karachi
Ph: 021-34857148, 021-34141329, 0333-2402474 info@3deducators.com, http://www.3deducators.com



http://www.3deducators.com/

Matrix 6.3

Training Program

About the Program Designer & Instructor

The “PRO-E” Program has been
designed and will be conducted the
Senior Engineers who has more than
Ten years experience in the field of
Development and Engineering
Management.

The Person are Certified where he has
been providing his services in industry
for last 12 years and conducting so many
different session with the PRO-E and
work or develop the real time
applications for here and abroad.

At present, faculty is working in the
same technology and working as a
senior position in the renown
organization, further he is also involved
in training and development for last
fifteen years.

100,000+ Students
have been Trained

since

1987

Inauguration
The Training Program will be

inaugurated by a senior member of
3DEducators.

Program Structure

No of classes per week 01 Class
Duration of each class 02 - Hour
Guided Hours 32 Hours
Non Guided Hours 12 Hours
Total Hours 48 Hours

Other Learning Activities

Classroom Assignments 08
Presentations by Trainees 01
Project 01
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Matrix Viewers

Create interactive images of your Matrix designs for your customers to
view via email or from your company’s website. These three dimensional,
photo realistic images provide full control to the viewer; allowing them to
spin, reposition, zoom in and out, and even change gem or metal materials
with immediate results! With your design opened in Matrix and a few
simple clicks using the Matrix Viewer tool, you can create files used to
share your designs with the world in an exciting new way - and they don't
need a 3D program to view it!

Stuller Gem Ordering

That's right! You can now order your diamonds & gemstones through
Matrix. Use the Stuller Gem Order Builder to specify the 4 C's and instantly
order/update your Stuller account with confidence that Stuller is the
largest DTC Sight holder and fulfillment house in the USA.

Stuller Studio CAD/CAM Services

Send your model to Stuller for manufacturing directly from the Matrix
Interface. Build your Matrix model and let Stuller Studio CAD/CAM Services
take care of the rest.
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Bonus Tools Integrated

The Chicago Bonus Tools have now been integrated into the Matrix
interface for ease of use. Each tool can now be found within its' respective
menu.

New Icons/features

Access more tools using the graphic icons within the Matrix Interface.
Instead of typing the command in the command line, access the tool with
one simple click of the mouse.

Tools Menu

Stuller Gem Ordering:

That's right! You can now order your diamonds & gemstones through
Matrix. Use the Stuller Gem Order Builder to specify the 4 C's and instantly
order/update your Stuller account with confidence that Stuller is the
largest DTC Sight holder and fulfillment house in the USA.

Gem Update:
Fix pesky broken gems using the Gem Update button.
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View Menu

Matrix Viewer:

This new and highly interactive 3D viewer allows customers to view and
interact with your 3D models outside of the Matrix Software. This tool will
add a new dimension to the approval process, and also provide a unique
feature to your website.

Surface Menu

Adjust Closed Surface Seam:
An oldie but goodie, we now have a button for the Adjust Closed Surface
Seam function.

New Render Tools

Sparkle:

Add glamour and life to any render with the new Sparkle builder. Send
your new animated render (with Sparkle’s included!) to your client via
email or use it on your website.

Movie Maker:

Sew a series of static images together and make an animated movie. Use
this comprehensive tool and include a watermark or picture in picture.
Fade your movie in and out to add a professional touch. This advanced tool
can be used for marketing or demonstration purposes.
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File Menu

Stuller Studio CAM Services:
Manufacturing your Matrix design has never been so easy. Link directly to
the Stuller Studio Cam Services website from inside the Matrix interface.

Info & Settings Toolbar

Clear History:
Clear the history on one or more parts of your model to end the

relationship between history enabled parts.
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Section I: Primary

Chapter # 1:
Introduction

An Introduction to Matrix 6.3

The F6 Key and Matrix 6.3
Tour of a Matrix Builder
Using Info & Settings Menu
Using Project Manager
Project Manager Database
The Top 11 Buttons

Using the File Menu

Using the Measure Menu
A Tour of the Interface
History and Matrix 6.3
Modeling in the Viewports
The Layers Menu

Using Master Job Bags
Using the Snaps Menu
“Cool Display Modes”
Using the View Menu
Basic Utilities Menu Tools
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Chapter # 2:

Building Shanks & Bands

Building Your First Ring
The Ring Rail Tool

The Profile Placer Tool
Create your own Profile
Using Sweep 1 History
The Outside Rail Tool
Using Sweep 2 History
Multi-Rail Sweep History
Profile End Cap

Adding Basic Gems

The Gem Loader Tool

Gem Positioned & MSR
Using Bezel Builder
Matching Gem Attributes
Emerald & Baguette Builders

Basic Setting Tools

Using Head Builder

Using “Pull Object to Rail”
Saving & Loading Styles

Using Heads Library

Emerald Profile & Cluster Tools
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Chapter # 3:

Closed Curve Tools
Curve Tools for Basic Design
The Circle Command
The Ellipse Command
The Rectangle Command
The Polygon Command

Fixing Problem Curves
The “Offset” Commands
The Two “Blend” Commands
The Fillet & Chamfer Tools
Using Curve Boolean

Curves on a Surface
Extract Isocurve Commands
Pullback & Project
The Center Line Tool
Other Curve Menu Tools
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Open Curve Tools
The Line Command
Arc & Arc Direction

Open or Closed Curve Tools
The Polyline Command
Interp Curve & Curve Tools

Tools to Modify Curves
Rebuild & Fit Commands
Eternity Ring Builder
Raised Band Builder
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Section Il - Intermediate

Chapter # 4:

Gems from Curves
Multiple Gems & Settings
Gems & Objects on a Curve
Advanced Cluster Builder
Gems Between 2 Curves
Building a Baguette Channel
Baguette Between 2 Curves
The Custom Gem Tool

Managing Multiple Gems
Using Gem Reporter
Using Gem Guides
Using Gem Update

Managing Multiple Gems
Using Gem Reporter
Using Gem Guides
Using Gem Update

Setting Multiple Gems
Creating a Prong Layout
Prong Editor
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Chapter # 5:
Builders Menu
Using Matrix Builders

Ring Builders
Eternity Ring Builder
Raised Band Builder

Design Element Builders
Pattern Builder
The Two Knot Builders
Jump Ring & Nautilus Builders

Award-Style Ring Builders
Signet Ring Builder
The Award Ring Builder
The Surface Pullback Tool

New Modeling Tools
Surface Inset

Intermediate Tools
The Curve Transform Tool

Suite # 7, Nobel Heights, Opposite Sales Tax House, KDA Scheme # 7, Main University Road — Karachi
Ph: 021-34857148, 021-34141329, 0333-2402474 info@3deducators.com, http://www.3deducators.com



http://www.3deducators.com/

A |

Matrix 6.3

Training Program

The Metal Piece Setting
The Channel Border Tool
The Gem Profile Tool

Gem Cutters
Cutters for 1 or Many Gems

Cutting Tools
Cut to Finger Rail Tool
Boolean Builder & Booleans

Tools for use with Booleans
Boolean-Related Commands

Chapter # 6:

Surfaces & Solids from Curves
Build, Edit Surfaces & Solids
The “Extrude” Tools
The “Pipe” Commands
The Revolve Commands

Creating Surfaces
Creating Simple Surfaces
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Tools to Mirror Designs
Mirror Mode & Mirror Shatter

Cutting Tools To Mirror Designs
Plane & Cube Cutters
Quad Flip Builder

Tools Menu Builders
The Ring Resizer Tool

Chapter # 7:

Intermediate Gem Tools
Intermediate Gem Tools

Pave Tools
Creating Simple Pave
Using Gem on Surface
Using Springs
Adding Pave Azures
Adding Pave Prongs

Prong & Bead on Surface

Auto Pave’: Advanced Designs
Using “Pave’ Sphere”
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Tools to Edit Surfaces & Solids Advanced Gem Tools
Cap Planar & Extract Surface Gem Control
The Blend Surface Command Gem Follow
Fillet & Chamfer Tools Fillet & Chamfer Tools
Basic Scale Tools Using “Object to Gem”

Bend, Twist, Taper, & Shear
The Cage & Cage Edit Tools
The Polar Array Tool

Make Downward Facing

Section lll - Advanced

Chapter # 8:
Advanced Profile & Rail Tools Advanced Surface Editing
Advanced Modeling Concepts Offsetting Surfaces
The Profile Sweep Tool Extend Surface
Custom Rail & Related Tools Rebuild Surface
Sweeping Custom Rail Rings Using Match & Merge
Using Profile Merge Using Unroll Surface
Dup Edge & Dup Border Untrim / Shrink Trimmed Surface
Orient 2 & 3 Points Using Move UVN
Using Rotate 3D Using the Soft Move Tools

Curves and CPlanes
The Blend Targets Menu
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Advanced Surface Creation

Sweep 1, 2, & Surface Modeling
Using the “Loft” Tool

Using Curve Network

Using the Patch Command
Cross Section Profiles

Using the Drape Tool

Using Height field from Bitmap

Chapter # 9: Chapter # 10:

Curve Tools: Objects on a Surface Using Matrix Art
Advanced Design Tools Matrix Art & Mesh Tools
Understanding UV Curves Using the Layer Menu
Adjust Closed Curve Seam Pt. Using the Picture Menu
Adjust Closed Surface Seam Using the Effects Menu
The Divide Curve Command Using the Sculpt Menu

Transform: Objects on a Surface Matrix Art Tools
Using the “Flow” Commands Convert to Bitmap
Using “Smart Flow"

Using The Array Tools Utilities Menu Tools
The Orient Tools & “Splop” Show Z Buffer

Solid: Objects on a Surface Mesh Tools

Boss, Rib, Slab, & Holes The Mesh Mapper Tool

Mesh Reducer
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Mesh Utilities

Using Apply Mesh UVN
Create & Fix Meshes

Chapter # 11:
V-Ray
Rendering With VRay
Using Lights
Tools to Enhance Renders
Sparkle Builder

Using Wire Compositor
Other Settings in Render

Advanced Rendering

Creating Environments
Saving User Environments

Creating Materials
Saving User Materials
Rhino & VRay Functions

Render Effects with Maps
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ONLINE LIVE CLASSES FACILITY AVAILABLE

Instructor Led Training

Real Time Presentations

Interactive Classes

Complete Notes and Other Stuff shall be provided through our Secure
Student Login Member's Area

For Online Live Classes, you may please download the Admission Form
through our website http://www.3deducators.com. Fill it properly and
attached the required document along with Picture and send back to
info@3deducators.com with scanned fee submitted voucher in the bank.
For Pakistan you may submit the fee at any MCB Branch with the title
of “3D EDUCATORS-TRAINERS & CONSULTANTS".

If you are outside Pakistan then you may transfer via Bank to Bank or
any western union, Fast Track, Money Gram or else International
Transfer Body.

After Admission, if you don’'t have GMAIL Account then you are
requested to kindly make one GMAIL Account and shared it
info@3deducators.com. Then further correspondence shall be made by
our institute official.

Extra Bandwidth Charges shall be incurred.

DISTANCE NOT MATTER

You can join in the live classes Sessions of 3D EDUCATORS - TRAINERS &
CONSULTANTS from anywhere of the world.
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PRECAUTIONARY MEASURES

= During Classes, you are requested to make sure that you are in isolated
room, where no noise should be there except your voice.

= Kindly Switch Off your Cell Phone during the class, because it will
disturb the quorum of class.

= |f you have taken the admission in the course online lonely, then
ethically it is recommended and suggested that you alone in the class.

= Recording of Lectures are not allowed at your end.

This world is emerging and growing in the 2Ist Century very rapidly
because of latest and remarkable technologies and its advancement. Due
to advancement of technology, we 3D EDUCATORS offer Live Interactive
class sessions

3D EDUCATORS believe on Information Technology and its systems. Now
you can also avail this facility at your home.

CONTACT US
021-34141329, 0333-2402474 info@3deducators.com
021-34857148 http://www.3deducators.com
Get the Admission Form MANAGEMENT

" 3D EDUCATORS
Download Form| ¥ TRAINERS & CONSULTANTS
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TERMS & CONDITIONS

WITHDRAWAL FROM THE CERTIFICATION OR DIPLOMA
Students are not allowed to withdraw from the CERTIFICATION/DIPLOMA. If a
student cannot continue the CERTIFICATION his/her fee will be forfeited.

CONDUCT AND DISCIPLINE

A disciplinary action, leading to rustication, will be taken against students whose
conduct is found objectionable at any time during the course of study. Reference
will be made to 3D Educators code of conduct.

EVALUATION AND GRADING

The performance of students is evaluated through continuous observation of a
student’s performance in the CERTIFICATION/DIPLOMA - class participation,
submission of assignments, quizzes and exercises.

The student will be examined through three hourly exams conducted at the
midterm and a final exam at the end of the program. Total marks for passing the
CERTIFICATION/DIPLOMA will be 70 out of a total of 100.

Students who do not meet the attendance or any other eligibility criteria will not
be allowed to appear in the final examination.

The following grading plan will be applicable for the CERTIFICATION/DIPLOMA:

87-100 81-86 72-80 66-71 60-65 Below 60

Students who are unable to appear for the final exam are required to submit a
written application stating the reason for not appearing for the exam. 3D
Educators reserves the right to approve or deny such applications. If approved,
the student will be allowed to sit for the exam within one month. Failure to do so,
the student will be resubmit the examination fee and sit the future schedule
exam. Without passing of the exams no certification will be awarded.
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Training Certificate Sample

7o CERTIFICATE

Invest In People the Ouly Asset that Appreciates...

Ghe Werlificate Witnesseth that
Dr. Muhammad Allama Iqbal <‘\\ |
Das Successfully Completed the 4E-Dours Graining of the
Jewelry Design Matrix CAD
Conducted By
3D EDUCATORS - TRAINERS & CONSULTANTS

From 22 Nov 2009 To 22 Jan 2010
CERTIFICATE ID: 3DCIA1010/5/2003093

Principal of Institute

Global Partner - International Management Research & Technology Consortium - IMRTC USA
Global Partner - PECB CANADA, Partner Institute of SDC - Government of Pakistan
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International Certificate of Authorization from IMRTC

IMRTG USA Recognized

—J GERTIFIGATE OF AUTHORIZATION M...

This is to Certify That IMRTC Authorized

3D EDUCATORS - TRAINERS & CONSULTANTS

to work as Training & Research Partner in capacity of
PARTNER THROUGH PAKISTAN CHAPTER
Jor the scope of activity shown below in accordance with the applicable rules of
the IMRTC. The use of this certification and the authority granted by this
Certificate of Authorization are subject to the provision of agreement set
Jorth in the application.

|9 RTG

The validity of this certificate is for Five Years from the date of Issuance
and will increase according to the performance
Issuance Date: 16 August 2017
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Chapter ID: AS2933770
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